
 

 

 

 

Experiment-1: 
Introduction to the hardware component various input output devices and 

their corporate 

 
Introduction to Hardware Components and Various Input/Output Devices in Corporate Settings 

In the modern corporate world, hardware components and input/output devices play a critical role in 

facilitating daily operations, increasing efficiency, and enhancing communication. This introduction 

provides an overview of these essential components and devices that are the backbone of corporate 

technology infrastructure. 

1. Central Processing Unit (CPU): The CPU is the brain of a computer system. It processes 

instructions and performs calculations, making it the heart of any computing device used in corporate 

environments. It determines the device's processing speed and overall performance. 

2. Random Access Memory (RAM): RAM is where a computer temporarily stores data and 

instructions it needs to process. In corporate settings, larger RAM capacities are crucial for handling 

complex tasks and multitasking. 

3. Storage Devices: Corporate environments rely on various storage devices, such as Hard Disk Drives 

(HDDs) and Solid-State Drives (SSDs), for data retention. These devices ensure data accessibility and 

are crucial for data backup and recovery. 

4. Input Devices: 

 Keyboards: Keyboards are the primary text input devices in corporate settings, used for data 

entry, communication, and various applications. 

 Mice and Pointing Devices: Mice enable users to navigate graphical interfaces, select, and 

interact with on-screen elements, making them indispensable for productivity. 

5. Output Devices: 

 Monitors: Monitors display visual information and provide a visual interface for users to 

interact with computer systems. They come in various sizes and resolutions to meet corporate 

needs. 

 Printers: Printers produce hard copies of digital documents and are essential for generating 

reports, memos, and other physical documentation. 

6. Network Devices: 

 Routers: Routers facilitate network communication within a corporate environment, 

connecting various devices and enabling internet access. 

 Switches: Switches manage data traffic within a network, ensuring efficient data transfer and 

communication among devices. 

 Firewalls: Firewalls protect corporate networks from security threats by monitoring and 

controlling incoming and outgoing network traffic. 

7. Scanners: Scanners are used to convert physical documents and images into digital formats, 

making them easier to store, share, and manage within corporate databases. 

8. Audio Devices: 

 Speakers and Headsets: Speakers and headsets are used for audio communication, 

presentations, and multimedia applications in corporate environments. 



 

 

 

 

 Microphones: Microphones enable audio input, such as voice communication, conference 

calls, and voice recognition software. 

9. Barcode Scanners: In inventory management and retail, barcode scanners are used to quickly and 

accurately capture product information, streamlining data entry and inventory tracking. 

10. Cameras: Webcams and cameras are used for video conferencing, remote meetings, security 

surveillance, and creating multimedia content for corporate communications and marketing. 

Corporate environments rely on a combination of these hardware components and input/output 

devices to create a robust technology infrastructure. The seamless integration and optimal use of 

these components enhance efficiency, productivity, and communication, contributing to the success 

of modern businesses. Understanding the role and function of each hardware component and device 

is essential for IT professionals and employees in corporate settings to effectively utilize and 

maintain these assets. 



 

 

 

 

Experiment-2: 
 

World memories RAM and ROM and its types various types of processes 

storage devices internal vs external? 

 
Memory, both RAM (Random Access Memory) and ROM (Read-Only Memory), play crucial 

roles in computer systems, as do various types of processors and storage devices. Here's an overview 

of each: 

 

1. RAM (Random Access Memory): 

RAM is a type of computer memory that is used to store data that the CPU (Central Processing Unit) 

is currently processing. It is volatile memory, meaning it loses its data when the computer is powered 

off. RAM is essential for the functioning of an operating system and running applications. There are 

various types of RAM, including: 

 

SRAM (Static RAM): Faster and more expensive. Used in cache memory. 

DRAM (Dynamic RAM): Slower but cheaper. Used as main system memory. 

2. ROM (Read-Only Memory): 

ROM is non-volatile memory that stores data that should not be modified or erased. It typically 

contains firmware and software that is essential for the computer to boot up. Types of ROM include: 

PROM (Programmable ROM): Can be programmed once. 

EPROM (Erasable Programmable ROM): Can be erased and reprogrammed. 

EEPROM (Electrically Erasable Programmable ROM): Can be electronically erased and 

reprogrammed. 

Flash Memory: A type of EEPROM that is used in modern storage devices like SSDs and USB 

drives. 

3. Types of Processors: 

Processors are the "brain" of a computer and come in various types, including: 
Central Processing Unit (CPU): The primary processor responsible for executing instructions in a 

computer. 

Graphics Processing Unit (GPU): Specialized processors for rendering graphics and performing 

parallel computations. 

Microcontrollers: Embedded processors used in devices like appliances and automobiles. 

Quantum Processors: Experimental processors designed for quantum computing. 

4. Storage Devices: 

Storage devices are used to store data and programs on a computer. They can be classified into two 

main categories: internal and external. 

 

Internal Storage Devices: 

 

Hard Disk Drives (HDD): Traditional mechanical drives that use spinning disks to store data. 

Solid State Drives (SSD): Modern storage devices that use flash memory, offering faster 

performance and durability. 



 

 

 

 

Optical Drives: Devices like CD/DVD drives for reading and writing optical discs. 

M.2 SSDs: Small form factor SSDs that connect directly to the motherboard for improved speed and 

space efficiency. 

 

External Storage Devices: 

 

USB Flash Drives: Portable and easy-to-use storage devices that connect via USB. 

External Hard Drives: Similar to internal HDDs but encased in an external housing for portability. 

Network Attached Storage (NAS): Storage devices that connect to a network, allowing multiple 

users to access and share data. 

Cloud Storage: Online storage services that store data in remote data centers accessible over the 

internet. 

Each of these components plays a vital role in the operation and functionality of computer systems. 

The choice of memory, processor, and storage devices depends on the specific needs and applications 

of the computer. 



 

 

 

 

Experiment-3: 
 

Instruction to operating systems overview of windows to server. 
An operating system (OS) is software that manages computer hardware, software resources, and 

provides various services to enable user applications to run. Windows is a family of operating 

systems developed by Microsoft, and there are different versions tailored for various use cases, 

including Windows Server. Here's an overview of Windows operating systems, with a focus on 

Windows Server: 

 

1. Windows Desktop Operating Systems: 

 

Windows 11: The latest version of the Windows desktop OS, designed for personal computers and 

laptops. It features a user-friendly interface, enhanced performance, and support for modern 

applications. 

 

Windows 10: The predecessor to Windows 11, still widely used on personal computers. It introduced 

the concept of a unified platform across devices and included features like Cortana, the virtual assistant. 

 

Windows 8.1: Known for its touch-friendly interface and integration with Microsoft services. It was 

a transition towards Windows 10. 

 

Windows 7: A highly popular OS known for its stability and user-friendliness. Extended support for 

Windows 7 ended in January 2020. 

 

2. Windows Server Operating Systems: 

Windows Server is a series of server operating systems developed by Microsoft, designed for managing 

networks, running server applications, and providing various enterprise services. The following are 

some versions of Windows Server: 

 

Windows Server 2022: The latest version as of my last knowledge update (January 2022). It includes 

features like improved security, enhanced virtualization capabilities, and support for modern 

containerization technologies. 

 

Windows Server 2019: Introduced features like Windows Admin Center for easier server 

management, enhanced security, and improved hybrid cloud integration. 

Windows Server 2016: Known for its software-defined datacenter features, such as Hyper-V 

virtualization and Storage Spaces Direct. It also improved security through Shielded Virtual Machines. 

 

Windows Server 2012 R2: Enhanced scalability, storage options, and introduced Hyper-V Replica for 

disaster recovery. 



 

 

 

 

Windows Server 2008 R2: Known for improvements in virtualization and scalability, with features 

like Hyper-V and Active Directory enhancements. 

 

Windows Server 2003: An older version that provided fundamental server features but reached the 

end of its extended support lifecycle in 2015. 

 

3. Key Functions of Windows Server Operating Systems: 

 

Server Management: Windows Server OSs provide tools like Windows Admin Center and 

PowerShell for managing servers, users, and resources. 

 

Active Directory: Used for user and resource management in a networked environment. 

 

File and Print Services: Windows Server allows sharing files and printers on the network. 

 

Web Server and Application Hosting: It can host websites and web applications using Internet 

Information Services (IIS). 

 

Virtualization: Hyper-V, included in many versions of Windows Server, allows for virtual machine 

management. 

 

Security Features: Windows Server includes security features like BitLocker, Windows Defender, 

and tools for group policy management. 

 

Networking Services: Provides network services like DNS, DHCP, and VPN. 

 

Cloud Integration: Many recent versions of Windows Server support integration with cloud services 

like Azure. 

 

Windows Server operating systems are typically used in enterprise environments to manage servers, 

run critical applications, and provide network services. The choice of which version to use depends 

on the specific needs and requirements of the organization. 



 

 

 

 

Experiment-4: 
 

Linux various versions of Android lOS capturing GPS enable pictures tools 

for file sharing to mobile to mobile system. 

Linux and Android are distinct but related in that Android, which is a mobile operating system, 

is built on the Linux kernel. Android OS versions vary, while Linux distributions cater to different use 

cases. Capturing GPS-enabled pictures and sharing files between mobile systems are common tasks 

that can be performed using various applications and tools. Here's an overview: 

 

1. Android Versions: 

 

Android versions are named after desserts or sweets, and they're released periodically with new 

features and improvements. Examples include: 

 Android 12 (As of my last knowledge update in January 2022)

 Android 11 (Released in 2020)

 Android 10 (Released in 2019)

 Android 9 (Pie)

 Android 8 (Oreo)

 Android 7 (Nougat)

 Android 6 (Marshmallow)

Each version may offer new capabilities and security enhancements. 

 

2. GPS-Enabled Picture Capture on Android: 

 

Android smartphones come with built-in GPS capabilities. To capture GPS-enabled pictures, you can 

use the device's camera app. When you take a photo, the GPS coordinates (latitude and longitude) are 

often embedded in the image's metadata (EXIF data). 

Many camera apps also allow you to enable or disable GPS tagging of photos. 

Third-party camera apps on the Google Play Store often provide additional features for capturing GPS-

enabled pictures. 

 

3. File Sharing on Mobile to Mobile Systems: 

 

To share files between mobile devices running Android, there are several tools and methods 

available: 

Bluetooth: Android devices support Bluetooth for sharing files wirelessly. 

Near Field Communication (NFC): NFC can be used for close-range file sharing between devices. 

WiFi Direct: Some Android devices support WiFi Direct, allowing for direct device-to-device file 

transfers over WiFi. 

Third-party Apps: Apps like "ShareIt," "Xender," or "Files by Google" can be used for fast and easy 

file sharing between Android devices. 



 

 

 

 

Cloud Services: Cloud storage services like Google Drive, Dropbox, and OneDrive allow you to 

store files in the cloud and share them between devices with the corresponding apps. 

4. Linux Distributions: 

Linux distributions, often referred to as "distros," are various flavors of the Linux operating system, 

each tailored to different use cases. Popular desktop Linux distributions include: 

 Ubuntu

 Fedora

 Debian

 CentOS

 Arch Linux

 Linux distributions can also be used on servers, embedded systems, and other specialized 

environments.

 

5. Linux Tools for File Sharing: 

 

 Linux offers various tools for file sharing between devices, including mobile systems. These 
tools can be used on both desktop Linux and Android devices:

 Samba: Allows Linux devices to share files with Windows devices on a local network.

 SSH (Secure Shell): Can be used for secure file transfers between devices over a network.

 FTP (File Transfer Protocol): Linux supports FTP for file transfers.

 NFS (Network File System): Used for sharing files between Linux systems on a network. 

When it comes to Android and Linux, Android is a mobile operating system based on the Linux 

kernel. Android devices have a wide range of versions, and you can perform various tasks, including 

GPS-enabled picture capture and file sharing, using built-in features and third-party apps. Linux 

distributions cater to diverse use cases and offer a variety of tools for file sharing.



 

 

 

 

Experiment-5: 
 

MS word 3 Over views of various. 

Microsoft Word is a widely used word processing application that is part of the Microsoft Office 

suite. It offers a range of features for creating, editing, and formatting documents. Here are three key 

overviews of Microsoft Word: 

1. Word Processing Software: 

 Document Creation: Microsoft Word allows users  to create documents, such as 

letters, reports, essays, and more. It provides a blank canvas where you can enter and 

format text, insert images and graphics, and create tables. 

 Text Formatting: Word offers extensive text formatting options, including font styles, 

sizes, colors, and effects. You can adjust paragraph alignment, spacing, and indentation. 

 Document Elements: You can insert headers and footers, page numbers, tables of 

contents, footnotes, endnotes, and citations. 

 Spell and Grammar Checking: Word includes built-in spelling and grammar checkers 

to help you proofread your documents. 

 Collaboration: It supports real-time collaboration through features like track changes, 

comments, and the ability to share and edit documents online with others. 

2. Templates and Styles: 

 Templates: Microsoft Word provides a variety of document templates for common use 

cases. These templates include pre-designed layouts and formatting, making it easy to 

create professional documents. Examples include resumes, brochures, newsletters, and 

more. 

 Styles: You can apply predefined or custom styles to your documents for consistent 

formatting. Styles encompass fonts, colors, paragraph spacing, and more. This ensures 

that your documents have a cohesive and polished appearance. 

3. Integration and Extensibility: 

 Integration with Office Suite: Microsoft Word is part of the Microsoft Office suite, 

and it seamlessly integrates with other Office applications like Excel, PowerPoint, and 

Outlook. You can easily copy and paste content between these applications. 

 Add-Ins and Macros: Word supports add-ins and macros, allowing you to extend its 

functionality. You can create custom macros using VBA (Visual Basic for Applications) 

to automate tasks and develop add-ins to enhance your workflow. 

 Cloud Integration: Microsoft Word can be used with cloud storage services like 

OneDrive, SharePoint, and Microsoft 365. This enables easy access to your documents 

from multiple devices and real-time collaboration with others online. 

Microsoft Word is a versatile word processing tool that is used in a wide range of professional, 

academic, and personal contexts. Its rich feature set, including document creation, formatting, and 

integration with other Office applications, makes it a powerful and popular choice for creating and 

editing documents. 



 

 

 

 

Experiment-6: 

Ribbons-usage of font -text box- line spacing bullets-page layouts-styles. 
In Microsoft Word, the Ribbon is the user interface that contains tabs, each of which offers various 

commands and tools for creating and formatting documents. Here's how you can use the Ribbon 

features for font formatting, text boxes, line spacing, bullets, page layouts, and styles: 

1. Font Formatting: 

 Home Tab: To format text, you can use the "Home" tab on the Ribbon. Here are some 

common font formatting options: 

 Font Type: Select the font style you want from the "Font" dropdown list. 

 Font Size: Choose the font size using the "Font Size" dropdown list. 

 Bold, Italic, Underline: Use the bold, italic, and underline buttons to apply 

these formatting options to selected text. 

 Font Color and Highlighting: You can change text color and apply 

highlighting using the "Font Color" and "Text Highlight Color" buttons. 

 Format Painter: To copy the formatting from one text to another, you can use the 

"Format Painter" button. 

2. Text Box: 

 Insert Tab: To insert a text box into your document, go to the "Insert" tab on the Ribbon 

and click on "Text Box." You can then draw the text box on your document and start 

typing inside it. 

3. Line Spacing: 

 Paragraph Group: You can adjust line spacing in the "Paragraph" group on the 

"Home" tab. Click the arrow in the corner of the group to open the "Paragraph" dialog 

box. In the "Indents and Spacing" tab, adjust line spacing using the "Line spacing" 

dropdown. 

4. Bullets and Numbering: 

 To create a bulleted or numbered list, select the text you want to format.
 In the "Home" tab, look for the "Paragraph" group.

 Click on the "Bullets" or "Numbering" button to apply the desired formatting.

 You can customize the bullet or numbering style by clicking the drop-down arrow next to 

these buttons.

 

5. Page Layouts: 

 Page Layout Tab: The "Page Layout" tab on the Ribbon provides options for 

adjusting the layout of your document. Here are a few key functions: 

 Margins: You can set margins for your document using the "Margins" 

dropdown. 

 Orientation: Change between portrait and landscape page orientation using 

the "Orientation" button. 

 Size: Adjust the page size using the "Size" dropdown. 

 Columns: Create multiple columns in your document with the "Columns" 

button. 



 

 

 

 

 Breaks: Insert page breaks or section breaks as needed with the "Breaks" 

button. 

6. Styles: 

 Home Tab: The "Styles" group on the "Home" tab allows you to apply predefined text 

styles to your document. Click on a style to apply it to the selected text. To modify 

styles or create custom styles, you can open the "Styles" pane and select "Manage 

Styles." 

The Ribbon in Microsoft Word is a powerful and convenient tool for performing various formatting 

and layout tasks in your documents. It provides quick access to a wide range of features that help you 

create professional-looking documents with ease. 



 

 

 

 

Experiment-7: 

MS word to mail merge macros designing a company letter pad. 

Creating a Mail Merge in Microsoft Word to generate company letterhead involves several steps. 

You can use macros to automate some of these tasks. Here's a simplified guide on how to do this: 

Step 1: Design the Company Letterhead 

1. Open Microsoft Word and create a new document. 
2. Design your company letterhead by adding the company logo, address, phone number, and any 

other branding elements you want to include. Make sure it looks the way you want it to appear 

on each letter. 

3. Save this document as a template so that you can reuse it for mail merges. Go to "File" > "Save 

As," and choose "Word Template (*.dotx)" as the file type. 

Step 2: Prepare Your Data 

1. Organize your recipient data in a format that can be used for mail merge, such as an Excel 

spreadsheet or a CSV file. 

2. Include columns for recipient names, addresses, and any other information you want to 

personalize in the letter. 

Step 3: Start the Mail Merge 

1. Open a new document in Word. 
2. Go to the "Mailings" tab and select "Start Mail Merge." 

3. Choose the type of document you're creating (in this case, "Letters"). 

4. Click "Select Recipients" and choose "Use an Existing List." Browse to the file containing 

your recipient data. 

Step 4: Insert Merge Fields 

1. Place your cursor in the document where you want to insert dynamic information (e.g., 

recipient's name, address). 

2. Click on "Insert Merge Field" from the "Mailings" tab and select the fields from your data 

source that you want to include. 

Step 5: Design the Letter Content 

1. Customize the letter content as needed, ensuring that you've included the merge fields where 

necessary. 

2. You can format the merge fields and add any other text or graphics you want. 

Step 6: Preview the Results 

1. Click "Preview Results" from the "Mailings" tab to see how each letter will appear with the 

data filled in. 

Step 7: Complete the Mail Merge 

1. Click "Finish & Merge" and choose "Edit Individual Documents." 
2. You can select all the records or specific records to merge. Click "OK" to create the merged 

documents. 

Step 8: Create a Macro to Automate the Process 

You can create a macro to automate the mail merge process. Here's a simple example of a macro: 



 

 

 

 

 

 
 
 

You can customize this macro to point to your specific data source, template, and desired output 

location. To run the macro, press "Alt + F8," select "PerformMailMerge," and click "Run." 

This macro opens your data source, opens your template, performs the mail merge, saves the merged 

documents, and closes the data source and merged documents. 

Please note that you'll need to adapt the macro to your specific file paths and data source details. 

Remember that using macros can be complex, and it's essential to understand Word VBA (Visual 

Basic for Applications) to create and run macros effectively. 

Sub PerformMailMerge() 

' Define the data source and main document 

Dim SourceDoc As Document 

Set SourceDoc = Application.Documents.Open("C:\Path\To\Your\Data\Source.docx") 

Dim MainDoc As Document 

Set MainDoc = 

Application.Documents.Open("C:\Path\To\Your\Letterhead\Template.dotx") 

' Perform the mail merge 

MainDoc.MailMerge.OpenDataSource Name:="C:\Path\To\Your\Data\Source.xlsx", 

AddToRecentFiles:=False, LinkToSource:=True, Connection:="Data 

Source=C:\Path\To\Your\Data\Source.xlsx;", SQLStatement:="SELECT * FROM 

[Sheet1$]" MainDoc.MailMerge.Destination = wdSendToNewDocument 

MainDoc.MailMerge.Execute 

' Close the data source document 

SourceDoc.Close 

 

' Save and close the merged documents 

MainDoc.SaveAs "C:\Path\To\Your\Merged\Output.docx" 

MainDoc.Close 

End Sub 



 

 

 

 

Experiment-8: 

Time table, letter writing. 

To write a time table letter in Microsoft Word, you can follow these steps: 

Step 1: Open Microsoft Word 

Open Microsoft Word on your computer. If you have a specific letterhead or template you'd like to 

use, open that document. Otherwise, you can start with a blank document. 

Step 2: Add Your Letterhead (Optional) 

If you have a pre-designed letterhead, insert it at the top of the document. You can do this by going to 

the "Insert" tab and selecting "Pictures" to insert your letterhead image, or you can simply paste it if 

it's already in your clipboard. 

Step 3: Date and Address 

At the top of  your document, include the date of the letter. Then, add the recipient's address, 

including their name, title, organization, and full mailing address. 

Step 4: Salutation 

After the recipient's address, add a formal salutation. For example: "Dear Mr. Smith," or "To Whom 

It May Concern," depending on your specific situation. 

Step 5: Introduction 

In the opening paragraph, introduce yourself or your organization and briefly state the purpose of the 

letter. For example: 

"I am writing to provide you with our upcoming timetable for the [event/program]." 

Step 6: Body of the Letter 

This is where you'll include the actual timetable. You can format this in a table or a list format, 

depending on your preference. Here's an example in a table format: 

Step 7: Closing 

In the closing paragraph, you can express your expectations or any additional information. For 

example: 

 



 

 

 

 

"We hope this timetable helps you plan your day accordingly and ensures that you don't miss any 

important sessions." 

Step 8: Complimentary Close 

Use a formal closing statement, such as "Sincerely," or "Best regards," followed by your name and 

your title. 

Step 9: Signature (If Printing) 

If you're printing the letter, you can leave space for your physical signature. You can also insert a 

scanned image of your signature. 

Step 10: Proofread and Save 

Before finalizing the letter, proofread it for any errors or typos. Save the document to your preferred 

location on your computer. 

Step 11: Printing or Sending 

You can print the letter on company letterhead or save it as a PDF for digital distribution. If sending 

digitally, you can attach it to an email or use any other preferred method of transmission. 

Remember to personalize the content of the letter with the specific details of your timetable, 

recipient, and event or program. 



 

 

 

 

Experiment-9: 
 

MS PowerPoint create number of slides 
To create a specific number of slides in Microsoft PowerPoint, follow these steps: 

Method 1: Using the "New Slide" Button 

1. Open Microsoft PowerPoint. 
2. In the PowerPoint presentation, click on the slide where you want the new slides to be added. 

This will determine the location of the new slides. 

3. Go to the "Home" tab in the PowerPoint ribbon. 

4. Find the "New Slide" button. Click the drop-down arrow next to it. 

5. A menu will appear with different slide layouts. Choose the desired slide layout for your new 

slides. 

6. Click on the "New Slide" button for as many slides as you want to add. PowerPoint will insert 

slides based on your selection. 

Method 2: Using Slide Sorter View 

1. Open Microsoft PowerPoint. 
2. Click on the "View" tab in the PowerPoint ribbon. 

3. Select "Slide Sorter." This view displays thumbnails of all the slides in your presentation. 

4. To add a specific number of slides, simply click and drag your mouse to select the number of 

slides you want to add. 

5. Right-click on one of the selected slides. 

6. Choose "Copy" to copy the selected slides. 

7. Right-click in the area where you want to insert the new slides. 

8. Choose "Paste." PowerPoint will insert the copied slides. 



 

 

 

 

Experiment-10: 
 

Drawings and graphics developing a professional presentation PowerPoint 

shortcut keys 
 
Developing a professional presentation in PowerPoint often involves working with drawings and 

graphics. Here are some useful shortcut keys to help you navigate and create graphics efficiently: 

Basic Navigation: 
 

 Ctrl + Z: Undo the last action.
 

 Ctrl + Y: Redo the last action.
 

 Ctrl + C: Copy the selected item.
 

 Ctrl + X: Cut the selected item.
 

 Ctrl + V: Paste the item you copied or cut.
 

 Ctrl + S: Save the presentation.
 

 Ctrl + N: Create a new presentation.
 

 Ctrl + O: Open an existing presentation.
 

 Ctrl + P: Print the presentation.
 

 Ctrl + F: Find text within your presentation.
 

Working with Shapes: 
 

 Ctrl + M: Create a new slide.
 

 Ctrl + D: Duplicate the selected object.
 

 Ctrl + G: Group selected objects.
 

 Ctrl + Shift + G: Ungroup selected objects.
 

 Ctrl + Arrow Keys: Move selected object in small increments.
 

 Shift + Arrow Keys: Resize the selected object proportionally.
 

 Ctrl + Shift + Arrow Keys: Rotate the selected object.



 

 

 

 

Text Formatting: 
 

 Ctrl + B: Bold selected text.
 

 Ctrl + I: Italicize selected text.
 

 Ctrl + U: Underline selected text.
 

 Ctrl + [: Decrease font size.
 

 Ctrl + ]: Increase font size.
 

 Ctrl + Shift + >: Increase font size.
 

 Ctrl + Shift + <: Decrease font size.
 

 Ctrl + E: Center align text.
 

 Ctrl + L: Left align text.
 

 Ctrl + R: Right align text.
 

 Ctrl + J: Justify text.
 

Working with Images and Graphics: 
 

 Ctrl + Shift + C: Copy the formatting of a selected object.
 

 Ctrl + Shift + V: Paste the formatting to another object.
 

 Ctrl + Alt + V: Open the Paste Special dialog for advanced options when pasting.
 

 Ctrl + K: Insert a hyperlink.
 

 Ctrl + Shift + D: Insert a new slide with a duplicate of the current slide.
 

These keyboard shortcuts should help you work more efficiently with drawings and graphics in 

PowerPoint as you create your professional presentation. Remember that keyboard shortcuts can save 

you a lot of time and streamline your workflow, so it's worth taking the time to learn and use them 

effectively. 
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